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Preface 
The Oracle MICROS Suites Management Installation Guide explains the installation and setup of Suites 
Management for sites running Simphony version 1.6 MR8 (and higher) and 9700 HMS version 4.0.  
This guide includes instructions to: 

• Install the Suites Management application 
• Install the Suites Service 
• Configure the Suites server on the enterprise and property levels  
• Configure the Simphony Enterprise Management Console (EMC) 

Related Documents 
For more information, see the following documents:  

• CAL Packages 

Document Revisions  
Revision Date Version 

1st March, 2015 Suites Management version 3.5 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com 
When contacting Customer Support, please provide the following information: 

• Product version and program/module name 
• Functional and technical description of the problem (include business impact) 
• Detailed step-by-step instructions to re-create 
• Exact error message received 
• Screenshots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for example, 3.5) 
or a later patch release (for example, 3.5.1). If you are installing the base release or additional patch 
releases, read the documentation for all releases that have occurred since the base release before you 
begin installation. Documentation for patch releases can contain critical information related to the 
base release, as well as information about code changes since the base release. 
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How Suites Management works - Simphony 
The following diagram illustrates the information flow through the Suites Management application 
and the communication flow from the enterprise to the workstation level.  
 

 
 
The enterprise and property levels contain different components as described in the following table. 
 

 
 
 
 
  

Level  Components Installed  

Enterprise   Suites Management application 
 Suites website 
 Suites Management database creation 
 

Property   Suites Web Service 
 Transaction Services 
 LSMSimService 
 

Workstation  Suites SIM scripts 
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System requirements 
Suites Management is compatible with the following platforms:  

 

 

 

 
 

Prerequisite steps 
• Install either 9700 HMS version 4.0 (or higher) or Simphony version 1.6 MR8 (or higher)  
• On the Suites Management Application server: 

• Install and enable Internet Information Services (IIS) version 7 (or higher) 
• Install and enable ASP.NET 4.0 

For the support of older versions of ASP.NET: 
o The Suites Management application uses controls that work well with 

ASP.NET 2.0, but IIS 7 needs IIS 6 back-compatibility in order to support 
ASP.NET 2.0. 

To install the IIS 6.0 Management Compatibility Components by using the Windows Server 
2008 Server Manager: 

1. Click Start; click Administrative Tools, and then Server Manager. 
2. In the left navigation pane, expand Roles, and then right-click Web Server (IIS), 

and select Add Role Services. 
3. On the Select Role Services pane, scroll down to Management Tools and select 

IIS Management Console. 
4. Scroll down to IIS 6 Management Compatibility and select all four of the 

checkboxes. 
5. Click Next from the Select Role Services pane, and then click Install at the 

Confirm Installations Selections pane. 
6. Click Close.  
7. A system restart is required. 

• Install an SSL certificate 
Follow the steps outlined using this link: https://technet.microsoft.com/en-
us/library/cc771816%28v=ws.10%29.aspx 

• Install the latest version of Adobe Acrobat Reader to view reports 
• Installers need to know the Microsoft SQL Server 2008 administrator’s username 

and password 
• For the Suites Service: 

• Install the latest version of Transaction Services  
• Required information from Simphony EMC 
• Workstation ID for the POSAPI client running Suites 
• Revenue center (RVC) number of the Suites RVC 
• Property ID of the RVC running Suites 

Category  Supported Products  

Operating Systems   Windows Server 2008 64-bit (with 32-bit applications 
enabled) 

 Windows Server 2008 R2 64-bit (with 32-bit applications 
enabled) 

Databases  
 

 Microsoft SQL Server 2008 
 Microsoft SQL Server 2008 R2 
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Required Suites Management version 3.5 browser settings 

Verify the browser settings outlined below to prevent possible browser-based issues. 

Microsoft Internet Explorer 
To access the Microsoft Internet Explorer settings:  

1. Click Tools on the browser’s toolbar, and then select Internet options. 
2. Click Delete under Browsing history on the General tab. 
3. Deselect Preserve Favorites website data, select Temporary Internet website data and click 

Delete. 
4. Click Apply. 
5. Click the Security tab. 
6. Click the Local intranet icon (if the Suites Management server is on property) or click 

Trusted Sites (if the Suites Management server is not on property). 
• Add the URL you need in the Sites area under the Privacy tab. 
• Click Trusted Sites and using the slider, ensure that the zone is set to a Low 

security level setting. 
• Click Apply. 

7. Click the Privacy tab. 
8. Click Sites and enter the URL of the Suites Management install, not the IP address nor the 

host computer’s name. The entry should include the domain name that matches the SSL 
certificate.   

9. Click Allow. 
10. Click OK. 
11. Click Advanced and set the following options: 

• Select Override automatic cookie handling. 
• Click Accept under First-party Cookies. 
• Click Block under Third-party Cookies. 
• Select Always allow session cookies. 

12. Click OK. 
13. Click Settings. 
14. Add the same URL that you added under Sites (see step 6 above) to the exempted Pop-up 

Blocker Settings. This enables popups for the Suites Management application, which are 
required. It also ensures that you use the correct site based on the provided URL. 

15. Click Close. 
16. Click the Connections tab. 
17. Click LAN Settings. 

• Deselect Automatically Detect Settings (unless required). 
• Disable the Proxy Server (unless required by the site). 

18. Click OK. 
19. Click the Advanced tab. 
20. Select the following options: 

Browsing section: 
• Go to intranet site when a single word is entered in the Address bar 
• Underline links – select Always 
• Enable third party browser extensions* 
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Multimedia section: 
• Show pictures 

Security section: 
• Empty Temp Internet Folder on Exiting Browser 

21. Deselect the following options: 
Security section: 

• Do not save encrypted pages to disk 
• Block unsecured images with other mixed content 

Browsing section: 
• Enable Suggested Sites  

22. Click Apply. 
23. Click OK. 

Mozilla Firefox 
To access the Mozilla Firefox settings: 
 

1. Click the Menu bar icon on the browser’s toolbar. 
2. Click Options. 
3. Click Content on the toolbar. 
4. Deselect Block pop-up windows. 
5. Click Privacy on the toolbar. 
6. Under History and Firefox will, select Use custom settings for history. 
7. Select Accept Cookies from sites. 
8. Select Never from the Accept third-party cookies options. 
9. Click Advanced on the toolbar. 
10. Click the Network tab. 
11. Click Settings under Connection. 
12. Select No proxy (unless required by the site). 
13. Deselect Auto-detect proxy settings for this network (unless required). 
14. Click OK. 
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Google Chrome 
To access the Google Chrome settings:  

1. Click the Menu bar icon on the browser’s toolbar. 

 
 

2. Click Settings. 
3. Scroll to the bottom of the page and click Show advanced settings… 
4. Click Content settings under Privacy. 
5. Select Allow local data to be set (recommended). 
6. Select Block third-party cookies and site data. 
7. Scroll further down to Pop-ups and select Allow all sites to show pop-ups. 
8. Click Done. 
9. Click Change proxy settings… under Network. 
10. Click LAN Settings. 

• Deselect Automatically Detect Settings (unless required) 
• Disable the Proxy Server (unless required by the site) 

11. Click OK. 
12. Click the Advanced tab. 
13. Select the following options: 

Browsing section: 
• Go to intranet site when a single word is entered in the Address bar 
• Underline links 
• Enable Third Party Extensions 

Multimedia section: 
• Show pictures 

Security section: 
• Empty Temp Internet Folder on Exiting Browser 

14. Deselect the following options: 
Security section: 

• Do not save encrypted web pages to disk 
• Block unsecured messages with other content 

Browsing section: 
• Enable suggested sites  

14. Click Apply. 
15. Click OK. 
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Client requirements 
Suites Management is a web-based application that users access through a web browser from client 
computers on the same network. A client computer accessing the Suites Management website must 
minimally have the following installed: 
Suites Management only requires one browser. Install one (or more) of the following: 

• Internet Explorer 8 or later 
• Firefox 31.4 or later 
• Google Chrome (latest version) 

To read Suites Management reports, install the following: 
• The latest version of Adobe Acrobat Reader  

Suites Management installation scenarios 
 
Suites Management contains two virtual directories in its components. One virtual directory is 
installed when the application is installed – typically at the enterprise level. The other virtual 
directory is installed with the Suites Management Service – typically on the local property level. 
Suites Management supports different configuration options, as listed in the following installation 
scenarios.   
 

• All in One Server – Simphony, Suites Management, and the databases are installed on the 
same computer. 

• Multiple Servers – Simphony is installed on one computer, the databases are installed on 
another computer, and Suites Management is installed on another computer at the 
enterprise level with the Suites Service installed at the property level. 

 

There are other potential installation scenarios. The example used in this document reviews the All 
in One Server installation scenario. The All in One Server type of installation is not recommended 
for sites that use Suites Management at multiple properties. 
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Installing Suites Management  
1. Obtain the Suites Management version 3.5 installation files from the Micros Members website 

and place it on the computer that is designated as the Suites Management application server.  
2. Double-click the SuitesSetup.exe file to begin the installation on the server that houses the 

Suites Management application and database. The SuitesSetup.exe installs the Suites 
Management application and database. 

3. Click Next. The installer checks the server to ensure that IIS is installed and the Suites 
Management installation wizard Welcome screen appears. 

4. Enter the Database Server information. 
• Database server that you are installing to: This is the server name or IP address of the 

computer running Microsoft SQL Server where the Suites Management database resides. If 
you are installing Suites in an All-In-One environment, the database name can remain (local) 
or local host. 

5. Select a connection method:  
• Windows authentication  
• SQL Server authentication using the Login ID and password below 

6. Enter a Login ID and Password for the Microsoft SQL Server authentication connection method. 
7. Click Next. 
8. Select the destination folder for the Suites Management web files from the Welcome to the 

Installation of… screen.  
• The default path is <Drive letter>:\Micros\LES\Suites. Although the installation drive path is 

configurable, the folder path should always be left at the default:   
<Drive Letter>:\Micros\LES\Suites. 

9. Click Next.  
10. Port# - Enter an unused Port number to use for Suites communication. 

11. SSLPort# - Enter the unique Port number that is used by SSL. 
• The port number selected for Suites Management and the SSL port number that the SUITES 

website is bound to, must match.  If a binding is made to a different port, the installer must 
edit the SUITES Web.config file and set the value of the DefaultHttpsPort tag to match the 
https binding. See the Install server certificate section for more information. 

12. Virtual: - Name the Suites Management virtual directory. 
• The default name for the Suites Management virtual directory is SUITES. 
• A website named SUITES will be created during the installation. Enter this name in the 

address bar of a browser to access the Suites Management website. If the virtual directory 
name is SUITES, the URL for the Suites Management website is 
http://ServerName:8001/SUITES/frmlogin.aspx. 

13. Click Next. 

14. Review the configured settings from the Start Copying Files screen.  
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• For All in One Server installation scenarios, when using SQL Server 2008 R2, the SQL 
Server Maintenance Plan writes the Suites database backup tasks to the C:\Program 
Files\Micros SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL\Backup folder. 

• For multiple server installation scenarios, after installing the Suites database, it is 
strongly recommended to access the database server and manually configure and 
schedule periodic Microsoft SQL Server backup tasks for the Suites database.  Here is an 
example of a backup task path:  
\\<ServerName or IP address>:<Drive letter>\Program Files\Microsoft SQL 
Server\MSSQL10_50.MSSQLSERVER\MSSQL\Backup 

15. Click Next. 
• Setup starts on the Setup Status screen and a progress bar appears as the installation 

proceeds. 
16. A prompt to run the Key Manager Utility appears. Click Yes to run the Key Manager utility.  
17. Enter and confirm the newly entered Passphrase from the Micros LSM Key Manager screen, 

and then click Update. 
 

 

18. Click Yes to continue, or No to address the recommendations to batch all credit cards and to 
perform backup tasks for both the Simphony and Suites Transaction databases.  
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19. Upon performing the first key rotation, the following message appears. Click OK. 
 

 
 
20. A message appears indicating that you must install a .PDF Reader in order to review Suites 

reports. 
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Installing Suites Service  
The SuitesServiceSetup.exe installs the Suites Service, which communicates with Transaction 
Services during the Go-Live process. For Simphony environments, it also installs the 
LSMWinService that communicates with Ops. In an enterprise environment, where there is one 
Suites Management server and multiple properties, you should install this service on-site at the 
property level. You must install Transaction Services on the property’s Point of Sales (POS) 
application server before running the SuitesServiceSetup.exe installation. 
You must install the Suites Service on the POS application server (for either 9700 version 4.0 HMS or 
Simphony version 1.6 MR8 (or higher) in order to utilize a PC Autosequence to execute the Check 
Regen process (which is an external program). See the Configure computer Autosequence section for 
more information. 

1. Obtain the Suites Management version 3.5 installation files from the Micros Members 
website. 

2. From the POS application server, double-click SuitesServiceSetup.exe to begin the 
installation and the Suites Service installation wizard Welcome screen appears. 

3. Click Next. 
4. Select Simphony or 9700 to identify the POS application communicating with Suites. 
5. Enter the name for the virtual directory used by the Suites Service. The default virtual 

directory name is SUITESSERVICE. The virtual directory automatically installs under the 
SUITES website on IIS. 

6. Select the path where the Suites Service installs from the Micros Suites Service Setup 
screen.  
• The drive path is configurable, however the folder path should always be set to:  

<Drive Letter>:\Micros\LES\Suites 
7. Click Next. 
8. Enter the interface information from the Simphony Interface Information screen.  

 
  

POS Application  Required configuration information  

Simphony 1.6   
 
 

 Transaction Srv 
 RVC Number (RVC ID number) 
 Workstation ID  
 LSM WS 
 Property ID 
 

9700 4.0  
 
 

 Transaction Srv 
 RVC Number (RVC ID number) 
 POS Interface Client Name 
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Field explanations for Simphony 1.6: 
• Transaction Srv – This is the web address for Transaction Services. The default is 

http://localhost/TSWebService/TSWebService_1_0.asmx. This may be different 
depending on the site. You must add the port number that Transaction Services is using 
to the web address: 
http://localhost:PortNumber/TSWebService/TSWebService_1_0.asmx. 

• RVC Number – This is the Suites revenue center number (RVC ID value). 
• Workstation ID – This is the Workstation ID number of the POSAPI client (required for 

Simphony 1.6 sites only). 
The fields configured here are specific to the site.  
 

 
Simphony 1.6 example 
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Field explanation for 9700 4.0: 

• RVC Number – This is the revenue center object number 
 

 
9700 4.0 example 

• For 9700 version 4.0 sites, after the Suites Service installation has been completed, you need 
to access the Suites application System Setup, System Parameters, Point of Sale Interface 
Settings, and enter the POSAPI workstation name in the POS Interface Client Name field. 

 
9700 4.0 environment example 
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• You can find the required Interface information in EMC and the Transaction Services 
Web.config file. To find the RVC ID number in the EMC, navigate to the property level, 
Property Information, RVC Configuration module. 

 

 
 

• For Simphony sites, in order to find the Workstation ID number in the EMC, navigate to the 
property level, Property Hardware, and then select the Workstations module. 

• For 9700 sites, in order to find the POSAPI workstation client name, in the EMC, navigate to 
the property level, Property Hardware, and then select the Workstations module.  Note the 
workstation name listed in the Name column and enter it in the Suites System Parameters 
settings. 

 

   
 

• The preceding screenshots are only examples. These numbers should be unique for every 
property and revenue center. 

9. Click Next. 
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10. Enter the required information from the Enter Additional Micros information screen to set 
up the Luxury Suites Management (LSM)WebService.   
• This information is required in Simphony environments, not 9700. 
 

For fresh installations of the Suites Service, the installation wizard prompts you to enter the 
following information. Default values have been assigned for these settings.  You could leave 
defaults or use blank settings and continue with the installation, however you would need to 
gather this information from the EMC and edit the SuiteEnv.isl file after the Suite Service 
installation is complete. See the Validate ISL Script Settings section for more information. 

Field explanations for Simphony 1.6: 
• LSM WS – Enter the URL of the LSMWebService 
• Property ID – The Property ID is the number that identifies the Suites property in the 

Suites database. This must have a Location ID value of 1. During installation, a default 
sample Suites property (with a Property ID = 1) is created in the Suites database.  

11. Click Next. 
12. Enter the Interface and Suites Billing Tender Media (Bill TMED) numbers from the Enter 

the Interface Number and Suites Billing Tender screen. 
 

Field explanations: 
• Interface – Enter the URL of the LSMWebService (default value =1) 
• Bill TMED – Enter the object number of the Suites Billing Tender Media record for PMS 

(default value = 105) 
13. Enter the Service Total Print Key and Service Total NO Print Key numbers from the Enter 

the Service Total Print Keys screen. These are comma-separated values where the first 
value is the Touchscreen Key Type and the second value is the Tender Media record 
number. 

Field explanations: 
• ST_PRT – The first value, ST, stands for the Touchscreen Key Type, which is 7 for a 

Tender Media key in the EMC, Touchscreen Design module. The second value, PRT, 
stands for the Print Check Service Total Tender Media record number used by the Suites 
revenue center. (default values  = 7,52) 

• ST_NPRT – The first value, ST, stands for the Touchscreen Key Type, which is 7 for a 
Tender Media key in the EMC, Touchscreen Design module. The second value, NPRT, 
stands for the NO Print Check Service Total Tender Media record number used by the 
Suites revenue center. (default values 7,51) 

 

14. Review the settings for the setup from the Micros Suites Service Setup screen. 
15. Click Next. 
16. The SQLite3Service Setup Wizard launches. Click Next. 
17. Select the Installation folder for the SQLite Service.  

• The path is configurable; however, the SQLite service needs to be installed using the 
following path: 
<Drive Letter>:\Micros\LES\Suites\Suites\Utilities 

18. Click Next. 
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19. From the Confirm Installation screen, click Next to confirm the installation of the SQLite 
Service. 

20. Click Close from the Installation Complete screen to continue with the Suites Service 
installation. 

21. The LSMSimService Setup Wizard launches (for Simphony environments only, not 9700).  
22. Click Next. 
23. Enter the install folder for the LSM SIM Service from the Select Installation Folder screen.  

The default installation path is:  
C:\Program Files (x86)\Micros Systems Inc\LSMSimServiceSetup.  

• Although this path is configurable, the folder path must be set to:  
<Drive Letter>:\Micros\LES\Suites\Suites\LSMSimService to function properly. 

24. Click Next.  
25. Click Next to confirm the LSM SIM Service installation. 
26. Click Close. 
27. Click Finish. 
 

After the Suites Service installation has completed, from the Suites Management website, you 
can export the POS application’s menu items and employees into the Suites database.  
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Post installation security step 
The Suites Management application and database has a default Employee, Employee Role, and 
Location pre-programmed in the system. This default location record cannot be deleted. The 
best practice procedure is to rename the default Suites location by accessing the Suites 
Management website to change the Location name to that of the property. During this step, it is 
strongly recommended to also change the default micros Suites username to a unique name and 
to assign a strong and PCI compliant password. For more information about creating strong 
passwords, click the following link:  
http://windows.microsoft.com/en-us/windows7/tips-for-creating-strong-passwords-and-
passphrases 

Install server certificate 
The Suites web page needs a server certificate to access parts of the Suites application. Each 
customer that uses Suites is required to purchase a SSL Certificate from an authorized certificate 
issuing authority. A self-signed certificate should not be used longer than absolutely necessary. 

1. Navigate to the IIS Manager. 
2. Click the server name under Connections. 
3. Double-click the Server Certificates icon. 
4. Select Create Self-Signed Certificate under Actions. 
5. From the Specify Friendly Name screen, enter Suites for the certificate name. 
6. Click OK. 
7. Assign the certificate to Suites by navigating to the IIS Manager and selecting the  Suites 

website (this is the default website). 
8. Click Bindings… on the side menu. 
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9. Click Add. 

 

11. Change the Type to https and leave the port set to 443 
12. Change the SSL certificate to the Suites Certificate that you just created.  

 

 

13. The Binding is now visible. 

 

14. Perform an IIS reset after completing this section.   
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Validate IIS settings 
 
Confirm that 32-bit applications are enabled on the Suites Application Pool.  
1. Navigate to the IIS Manager, and select Application Pools. 
2. Right-click Suites and select the Advanced Settings link. 
3. Verify that the Enable 32-Bit Applications setting is set to True. 

 
  

22 
 



  

Validate the Suites settings 

1. Navigate to the IIS Manager, and select Application Pools. 
2. Right-click Suites and select the Basic Settings link. 
3. Verify that the Suites settings match those shown below: 
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Validate LSM Closed Check Client settings 

Validate that the highlighted settings in the LSMClosedCheckClient.exe.config file are correct.   
1. Navigate to <Drive Letter>:\Micros\LES\Suites\Utilities.  
2. Enable the Network Service User to have full access to the Suites folder and subfolders. 

 
<add key="LocationId" value="1"/> 
<add key="LSMClosedCheckServiceUrl" 
value="http://localhost:8000/Suites/LSMWebService.asmx"/> 
<add key="SimphonyTSWebServiceUrl" 
value="http://localhost:8000/TSWebService/TSWebService_1_0.asmx"/> 
<add key="WSId" value="80"/> 
<add key="ClosedDays" value="2"/> 
  <add key="SaveTextFiles" value="1"/> 
<add key="LSMRvcMaster" value="20"/> 
  <add key="TotalsSet" value="0" />     
  <add key="ExportDir" value="${DRV8700}\Suites\export\checks" 
/> 
  <add key="ExportArchiveDir" 
value="${DRV8700}\Suites\archive\checks" /> 
  <add key="ExportArchiveDays" value="365" /> 
  <add key="ExportDefsDir" value="${DRV8700}\Suites\export\defs" 
/> 
  <add key="ExportDefsArchiveDir" 
value="${DRV8700}\Suites\archive\defs" /> 
  <add key="ExportDefsArchiveDays" value="365" /> 
  <add key="QueueDir" value="${DRV8700}\Suites\export\queue" /> 
 

• LocationId: Record number for the Suites property 
• LSMClosedCheckServiceUrl: URL for the Suites Management Service 
• SimphonyTSWebServiceUrl: URL for Transaction Services  
• WSId: Workstation ID for the POSAPI client 
• ClosedDays: This setting controls the amount of time that Transaction Services returns 

checks. The configurable values are 0 for all checks, or 2 for the current business date’s 
checks. The default and recommended value is 2. 

• LSMRvcMaster: Record number for the Suites revenue center 
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Configuring Simphony \ 9700 EMC 
This section contains configuration instructions for Suites Management in the EMC.  

Configure CAL Packages – Simphony only 
You must create a CAL package in EMC for the Suites package that will be added in the Create 
Suites CAL Packages on the Server section.  
1. In the EMC, navigate to the enterprise level, Hardware, and select CAL Packages. 
2. Insert a new CAL Package using the + button on the toolbar. 
3. Enter the following information: 

Field Description 

Name Enter Suites. 

Platform Type Select the platform type for the model of workstation being used in the 
Suites revenue center. Set this package to be sent to the workstation 
model that the site is using, however you must place a copy of the files 
in that model’s folder and create a proper setup.dat file to send the files 
to the correct pathways on the workstation. 

Folder Name Enter Suites. 

Deployment Order The CAL Client Package should always be enabled and should always 
be sent down first, so that the most recent version of the CAL Client is in 
use by the workstation(s). 

 
4. Click Add to add a deployment for each workstation in the Suites revenue center. 
5. Configure the deployment as follows.  

• Deployment Type:  2 - Specific Service Host 
• Service Host:  Each workstation in the Suites revenue center 
• Action to Take:  0 – Install 
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Configure Interface for Simphony 
Configure a new interface for the POS client(s) to communicate with the LSM Suites Services 
Listener. 
1. In the EMC, navigate to the enterprise level, Hardware, and select Interfaces. 
2. Insert a new interface record using the + button on the toolbar. 
3. Configure the settings as follows: 

• Name:  Suites 
• Communication Name:  Suites 
• Interface Type:  PMS/SIM 
• Communications Type:  TCP/IP 
• Timeout:  30 
• ISL Script Name:  SuiteMgt 

4. Click the Options tab and select the following options: 
• 1 - Use 19 Digit Reference Entry for PMS Inquiries 
• 2 – Enable Interface Log 
• 3 – Allow Inquiry without Sign-In 
• 5 – ON = Use 9 digits for Terminal ID’s; OFF = Use 2 digits for Terminal ID’s 
• 8 – Enable Offline Posting 

5. Enter the TCP Host Name and Port Number in the TCP Communications section.  

• This is the name or IP address of the machine where the Suites Service is running. 

6. Click the Properties tab. Select the property that is using Suites Management.  
• Assign only one property for this interface. 

7. Assign the interface to a service host. 
• The service host for the Suites Management interface must be the same machine running 

the Suites Service and Transaction Services at the property level. 
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If multiple properties in the same enterprise are using Suites Management, add a new interface 
record for each property. Repeat the steps in this section for each property running Suites 
Management.  
If the application server or any other computer is the service host for this interface, move the 
servicehost.xml file to the Simphony folder on that computer. Obtain the updated 
servicehost.xml file at: 
 <Drive letter>:\Micros\Simphony\EGatewayService\CAL\ServiceHosts 
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Configure Interface for 9700  
Configure a new interface for the POS client(s) to communicate with the LSM Suites Services 
Listener. 
1. Navigate to the EMC, Configurator, System Hardware, and select Interfaces. 
2. Insert a new interface record using the Insert Record icon  on the toolbar. 
3. Configure the settings as shown below: 

• System Name:  Suites 
• Service Type:  0 - PMS/SIM 
• Type:  1 - TCP 
• Communications Type:  TCP/IP 
• Timeout:  30 
• ISL Script Name:  SuiteMgt 

4. Enter the TCP Host Name and Port Number in the TCP Communications section.  
• This is the name or IP address of the machine where the Suites Service is running. 

 

5. Enable the following options: 
• Use 19 Digit Reference Entry for PMS Inquiries 
• Enable Interface Log 
• Allow Inquiry without Sign-In 
• ON = Use 9 digits for Terminal ID’s; OFF = Use 2 digits for Terminal ID’s 
• Enable Offline Posting 
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Configure revenue center – Simphony  
 
1. In the EMC, navigate to the revenue center level, RVC Information, select RVC Parameters, and 

select the Format tab. 
2. Set the Number of Guest Check Information Lines field to 10.  This allows Suites information 

to be contained in the check detail area. 
3. Click the Interfaces tab.  
4. Set one of the eight Interfaces fields to assign the use of Suites Management to that revenue 

center and Save. 

Configure revenue center – 9700 
1. In the EMC, Configurator, select the revenue center that is running Suites from the Revenue 

Center Selector dropdown box.  
2. Navigate to RVC Information, select Parameters, and select the Format tab. 
3. Set the Number of Guest Check Information Lines field to 10.  This allows Suites information 

to be contained in the check detail area. 
 

 
 

4. Click the Interfaces tab.  
5. Set one of the eight Interfaces fields to assign the use of Suites Management to that revenue 

center and Save. 
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Configure menu items - Simphony 

Menu Item Classes 
1. In the EMC, navigate to the revenue center level, Menu Items, and select Menu Item Classes. 
2. Click the Options tab. 

Set the following options in the Suites Management revenue center: 
• 10 – ON = Use Sub Level Pricing; OFF = Use Main Level Pricing – Deselect this option for 

all menu items to be rung up in the Suites Management revenue center. 
• 34 – Item is Beverage – Select this option for all menu items that are beverages in the Suites 

revenue center. 

Menu Item Definitions 
1. In the EMC, navigate to the revenue center level, Menu Items, and select Menu Item 

Maintenance. From the Record Type dropdown menu, select Menu Item Definition and click 
Search. 
• Menu items utilized by Suites Management cannot have more than one definition assigned 

to it. The Suites Management application only recognizes the first definition for a menu 
item. 

• Menu items must have an NLU number associated with them. In Simphony environments, 
Suites cannot recognize NLU numbers that exceed 10 digits. The NLU Group for each menu 
item can be zero, but the NLU number is necessary to import the items into the Suites 
Management database. This allows operators to place orders by NLU number. 

Menu Item Prices 
1. In the EMC, navigate to the revenue center level, Menu Items, and select Menu Item 

Maintenance. From the Record Type dropdown menu, select Menu Item Price and click Search. 
• Menu item price records must have at least one price record whose Active On Level setting 

is not 0 – All Levels. Suites Management does not recognize prices that are active on level 0 
– All Levels. 
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Configure menu items - 9700 

Menu Item Classes 
1. In the EMC, Configurator, navigate to Menu Items, select Maintenance, Maintenance, and search 

using the Class, by Type/Itemizer selection from the dropdown menu. 
2. Select the Menu Item Class to be edited. 
3. Click the Options tab. 

Set the following options for every Menu Item Class used in the Suites Management revenue 
center: 
• 10 – ON = Use Sub Level Pricing; OFF = Use Main Level Pricing – Deselect this option for 

all menu items to be rung up in the Suites Management revenue center. 
• 34 – Item is Beverage – Select this option for all menu items that are beverages in the Suites 

revenue center. 

Menu Item Definitions 
1. In the EMC, Configurator, navigate to Menu Items, select Maintenance, Maintenance, and search 

using the Definition, by Maj/Fam Grp selection from the dropdown menu. 
• Menu items utilized by Suites Management cannot have more than one definition assigned 

to it. The Suites Management application only recognizes the first definition for a menu 
item. 

• Menu items must have an NLU number associated with them. In 9700 environments, Suites 
cannot recognize NLU numbers that exceed 10 digits. The NLU Group for each menu item 
can be zero, but the NLU number is necessary to import the items into the Suites 
Management database. This allows operators to place orders by NLU number.  

Menu Item Prices 
1. In the EMC, Configurator, navigate to Menu Items, select Maintenance, Maintenance, and search 

using the Definition, by Maj/Fam Grp selection from the dropdown menu. 
2. Each menu item definition record has a Price tab where menu item prices are handled. 

• Menu item price records must have at least one price record whose Active On Level setting 
is not 0 – All Levels. Suites Management does not recognize prices that are active on level 0 
– All Levels. 

  

31 
 



  

Configure Touchscreen - Simphony \ 9700 
Before a Suites event, initiate the Go-Live process 
function from the Suites Management website to create 
checks in the Simphony system. Program a SIM inquiry 
button to pick up the checks in Ops. 
Program a button on the Suite Attendant screen to call 
the Suites Management SIM function for picking up a 
Suites check. Program the touchscreen key using the 
settings depicted here. 
 
Remove all reopen checks, pickup check SLU’s, and 
function buttons from the employee’s screen. Suites 
checks must be picked up using the Pickup Suites button 
for the specific suite information to be written correctly to 
the check. 
 

 
 

 
 
 

Configure PC Autosequence – Simphony only 
During the Start of Day process, via PC Autosequences, the system can automatically import the 
Suites closed checks into the Suites Management database  using the LSMClosedCheckClient.exe file 
as long as the Suites Service is installed on the Simphony application server. The 
LSMClosedCheckClient.exe is located here:  

<Drive Letter>:\Micros\LES\Suites\Suites\Utilities directory.  
1. Copy the LSMClosedCheckClient.exe file to the <Drive Letter>:\Micros\Simphony\etc directory 

on the Simphony application server. (If the site has multiple application servers, copy the file on 
the server running the Suites Service.) 

2. Configure a PC Autosequence in EMC to run the LSMClosedCheckClient.exe nightly. In the 
EMC, navigate to the enterprise level, select Tasks, and then select PC Autosequences. 

3. Insert a new PC Autosequence.  
4. On the General tab, configure the settings as follows. 

• Name:   Enter Suites Check Export 
• Allowed Properties:  Select the property that uses Suites Management.  
• Privilege Group:  Set the privilege group for users to run this Autosequence. Entering 0 

(zero) allows all users with EMC access to run this Autosequence. 

• Parameters:  Click Add to add a new parameter. Select Property Number as the     
Parameter. Enter the Property Number in the Value column.  
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• Click the Steps tab. 
 

 
 

5. Configure the settings as follows: 
• Step Type: Run External Program 
• Parameters: Click Add to add a parameter  
• Select the External Program File Path option 
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6. Enter the absolute path of the LSMClosedCheckClient.exe in the Value field.  
The file is located here:  

<Drive Letter>:\Micros\Simphony\etc\LSMClosedCheckClient.exe 
• Click Add to add another parameter. 
• Select the External Program Arguments option.  
• Enter -simphony_checks in the Value column. 
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Validate ISL Script Settings 
 

If Suites and Simphony are installed on the same server, during the initial Suites Service installation, 
four ISL files are copied to the following path:  
<Drive Letter>:\Micros\LES\Suites\Suites\SuitesSERVICE\SIMScripts  
The path is configurable, but could change depending on the path entered during the Suites Service 
Installation section. 
When upgrading Suites, any new ISL scripts are written to this path: 
<Drive Letter>:\Micros\LES\Suites\Suites\SuitesSERVICE\SIMScripts folder. 

1. Navigate to <Drive Letter>:\Micros\LES\Suites\Suites\SuitesSERVICE\SIMScripts.  
2. Open the file named SuiteEnv.isl. 
3. Under the Start user configuration section, change these lines to match the information in EMC.  

//---------------------------------- 
// Start user configuration section 
//---------------------------------- 

var LSM_INTFC : n3 = 1 
var LSM_RVC : n9 = 2 

4. Access the LSM_INTFC file through the RVC Parameters module in EMC.  
5. Click the Interfaces tab.  
6. There are eight possible interfaces, including one for Suites. Use the record number of the Interfaces 

field in this file.  
 

 
 

The preceding example shows the Suites interface as #2, so the file line in SuiteEnv.isl should be 
updated to var LSM_INTFC : n3 = 2 
Obtain the LSM_RVC number by looking in the RVC Configuration module on the property level in 
EMC. This field requires the RVC object number.  
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In the preceding example, the RVC object number is 404. So the line in the .isl should be corrected to 
look like var LSM_RVC : n9 = 404 
Continuing on, the highlighted lines in the following example for the SuiteMgt.isl file must be 
validated to ensure they are correct. If the workstations at the site are Win32 clients, the paths must 
be edited to reflect the proper location for the directories. 

 Example: %AppRoot%POSClient\sim is the directory for the var custom_dir. 
//---------------------------------- 
//  Start user configuration section 
//---------------------------------- 

var LSM_INTFC : n3 = 1 
var LSM_RVC : n9 = 2 

var micros_drv : a3 = "M:" 
var custom_dir : a100 = "CF\POSClient\sim" 
var import_dir : a100 = "CF\POSClient\sim" 
var log_dir : a100 = "CF\POSClient\log" 
var bin_dir : a100 = "CF\POSClient\bin" 
var AlphaTouch : n3 = 64 

//--------------------------- 
// New log directory 4 Simphony 
//--------------------------- 

var log_dir_simphony : a100 = "CF\POSClient\log" 
 

7. Navigate to <Drive Letter>:\Micros\Simphony\EGatewayService\CAL\WS5A\Packages.  
For this example, we are creating the folder for a CE WS5a. This may differ depending on the 
workstation model that is being used at the site. 

8. Create a Suites folder. 
9. Copy the files from <Drive Letter>:\Micros\LES\Suites\Suites\SuitesSERVICE\SIMScripts folder 

and paste them in the Suites folder <Drive 
Letter>:\Micros\Simphony\EGatewayService\CAL\WS5A\Packages\Suites.  

10. Create a setup.dat file for this folder. Continuing with the CE example, the Setup.dat should 
look like this: 

NAME,Suites, 

VERSION,1.6.2.2, 

TRANSFERFILE,SuiteMgt.isl,\CF\POSClient\sim\SuiteMgt.isl, 

TRANSFERFILE,SuiteMgtPrt.isl,\CF\POSClient\sim\SuiteMgtPrt.isl, 

TRANSFERFILE,SuiteMgtScreen.isl,\CF\POSClient\sim\SuiteMgtScreen.isl 
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Create Suites CAL Packages on the Server - Simphony 
 

You must create CAL Packages on the Simphony application server to download the Suites ISL files 
to each workstation in the Suites revenue center. 
Copy the following files: 
• SuiteEnv.isl 
• SuiteMgt.isl 
• SuiteMgtPrt.isl 
• SuiteMgtScreen.isl 

 

These files are located at: <Drive Letter>:\Micros\LES\Suites\Suites\SuitesSERVICE\SIMScripts 
folder. 
Create a CAL Package for each workstation type the site is using (for example, WS5, WS5A, KW270) 
in each workstation directory on the server. Create the CAL packages at the following location: 
<Drive Letter>:\Micros\Simphony\EGatewayService\CAL\WS5A\Packages 
The highlighted part of the path changes depending on the workstation type. For example, if the 
workstations in use at the site are WS5, the path is: 
<Drive Letter>:\Micros\Simphony\EGatewayService\CAL\WS5\Packages 
In each directory, create a folder called Suites. Copy the ISL files listed above to the newly created 
Suites folder. 
Copy the setup.dat file included with the installation to the Suites CAL Package folder. 
The setup.dat should read as follows for CE workstations: 
NAME,Suites, 
VERSION,1.6.2.1, 

TRANSFERFILE,SuiteMgt.isl,\CF\POSClient\sim\SuiteMgt.isl, 
TRANSFERFILE,SuiteMgtPrt.isl,\CF\POSClient\sim\SuiteMgtPrt.isl, 
TRANSFERFILE,SuiteMgtScreen.isl,\CF\POSClient\sim\SuiteMgtScreen.isl 

 

Modify the setup.dat for Win32 clients and so it reads as follows: 
NAME,Suites, 
VERSION,1.6.2.1, 

TRANSFERFILE,SuiteMgt.isl,%AppRoot%POSClient\sim\SuiteMgt.isl, 
TRANSFERFILE,SuiteMgtPrt.isl, %AppRoot%POSClient\sim\SuiteMgtPrt.isl, 
TRANSFERFILE,SuiteMgtScreen.isl, %AppRoot%POSClient\sim\SuiteMgtScreen.isl 
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Enable revenue center and employee roles to pick up unassigned checks 
The employees and the revenue center need permission to pick up the unassigned checks that are 
created through the Suites GoLive function.  
Enable the revenue center to use unassigned checks: 
1. In the EMC, select the revenue center level, select RVC Parameters, and then select the Posting 

and Control tab 
2. Go to Control and select option [23 - Allow Pickup/Creation of Unassigned Checks]. 
Enable the employee Role to pick up the unassigned checks: 
1. In the EMC, select the enterprise level, select Roles, and then select the Guest Checks tab. 
2. In the Add/Transfer/Pickup options, select the option [Authorize/Perform Creation and Pickup 

of Unassigned Checks]. 

Configure Suites Management Server  
The SuitesConfig.exe is used to configure the A/R Export file directory and the POSAPI workstation 
name. Making changes in this application forces the web services to restart, so it is recommended 
that no users be logged in to the website while the changes are being made. 
1. Navigate to <Drive Letter>:\Micros\Suites\Setup.  
2. Double-click SuitesConfig.exe.  
 

 
 

3. Enter information in the following fields: 
• A/R Export File Directory – This is the directory where the A/R Export Files are created.  
• POSAPI Workstation Name – This is the name of the POSAPI client that is used by 

Transaction Services and the Go-Live process.  
4. Click OK. 

 
 

5. Click Yes to save the settings, or No to review them again. 
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Running Suites Key Manager 
This section outlines the steps for running the Key Manager utility for Suites. Suites can use credit 
cards during the Go-Live process and in reports, and the Suites Key Manager enables the cards to be 
encrypted when stored into the database.  

1. Navigate to the path <Drive Letter>:\Micros\LES\Suites\bin folder.  
2. Double-click the KeyManager.exe file.  
 

 
 

3. Enter the default username and password. The defaults are Username = micros Password = 
micros. 

 

 
 

4. Click OK to log in to the Key Manager Utility. 
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5. Enter a Passphrase to encrypt secure data.  
6. Click Update to update the Passphrase. 

 

 
 

7. The following message appears for the first key rotation. 
 

 
 

8. Click OK. A progress bar appears, showing the status of the Database Re-Encryption. 
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9. Click OK when finished. 
 

 
 

10. Click OK on the Change Passphrase Result dialog. 
 

 
 

11. Click Yes on the Update Passphrase dialog. 
 

 
 
12. After the installation is complete, install a PDF reader to view reports. 
13. Click Finish. 

Password security 
As a Suites Management post-installation step and prior to going “live” at the property, it is crucial 
to change the “micros” default user’s password in order to comply with Payment Card Industry 
(PCI) Standards. When creating a strong password, it is highly recommended the use of the 
following standards: 
Include at least one character from at least three of the following classes: lowercase letters, uppercase 
letters, numerals, punctuation (for example, #, |, $, %, and spaces).  
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Add Network Service access to Suites folder 
 

To allow proper logging and access required in Suites Management, you must grant the 
NETWORK SERVICE user full permissions to the Suites folder. The Suites folder is located 
in the path specified during the installation process. Typically the path to the Suites folder 
would be: 
<Drive Letter>:\Micros\LES\Suites 
   

1. Right-click on the Suites folder. 
2. Click Properties. 
3. Click the Security tab. 
4. Click Edit. 
5. Click Add. 
6. Type NETWORK SERVICE in the object names to select window and click OK. 
7. Select Full Control under the Allow column and click Apply and OK. 
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